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Your SANYO product is designed and manufactured with high quality materials and components which
can be recycled and reused.

This symbol means that electrical and electronic equipment, at their end-of-life, should be disposed of
separately from your household waste.

Please dispose of this equipment at your local community waste collection/recycling centre.

In the European Union there are separate collection systems for used electrical and electronic products.

Please help us to conserve the environment we live in!
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- The apparatus shall not be exposed to dripping or
splashing.

- Do not drop the player or subject it to strong shocks.
- Do not use where there are extremes of temperature

(below 5°C or exceeding 35°C).

- IBM and PC/AT are registered trademarks of
International Business Machines Corporation.

- Microsoft, Windows MediaTM, and the Windows® Logo
are trademarks or registered trademarks of Microsoft
Corporation in the United States and/or other countries.

- Windows MediaTM Player is trademark
or registered trademark of Microsoft
Corporation.

- Adobe (Acrobat) Reader is a registered trademark of
Adobe Systems Incorporated.

- Other system and product names generally are the
registered trademarks or trademarks of the respective
development manufacturers. The symbols TM and ® are
not shown in this manual.

- High volume levels can create potentially dangerous
situations by drowning out surrounding sounds. Use
caution when driving while operating the player, and
obey all applicable laws.
Do not play your headphones at a high volume level.
Hearing experts advise against continuous extended
play.
If you experience a ringing in your ears, reduce the
volume or discontinue use.

- This player contains an internal Lithium Ion Battery.
The battery or the player should not be disposed of in
a fire.
The battery or the player should not be thrown in the
trash.
The battery or the player may require recycling in
accordance with local laws. Contact your local
regulatory authorities for more information.

- This battery is disposable. As it is charged and used,
the amount of time it lasts will eventually get shorter
and shorter. Consult your dealer when replacing the
battery.

Precautions
- SANYO takes no responsibility for data loss due to

power cuts or damage to the player.
- The Player (Internal Hard Disk)

The player has a built-in hard disk. The internal hard
disk is susceptible to shocks, vibration, and changes in
temperature. It might sometimes be impossible to read
or write data due to damage under certain usage
conditions. Use the player to store data temporarily.
Do not use it for permanent data storage.

- To avoid potential risk of data loss caused by accidental
operation or malfunction of the player, we recommend
that you save a backup copy of your data on a PC, etc.

- Recording copyright material without permission of the
copyright owners is usually an infringement. If you
wish to re-record copyright material, permission from
the copyright owner is necessary. SANYO does not
approve of, and cannot be held responsible for, any
unlawful use of this machine.

Note:
This handling description is created prior to product
development.
When a part of the product specification must be changed
to improve operability or other functions, priority is given to
the product specification itself. In such instances, the
instruction manual may not entirely match all the functions
of the actual product.
Therefore, the actual product and packaging, as well as
the name and illustration, may differ from the manual.

The screen/LCD display shown as an example in this
manual may be different from the actual screen/LCD
display.
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Controls

  1. Play/Stop, Top menu, Set button (m)
  2. Volume, Skip/Search, Menu select button

(o, p, d, c)
  3. LCD display
  4. Necklace connection hole
  5. Headphones socket ( )
  6. Reset switch (Rear of the unit)
  7. Hold switch (b HOLD)
  8. USB terminal
  9. Power, Play/Stop button (a/n z)
10. Menu button (MENU)
11. Repeat button (REPEAT)

LCD display
  1. Elapsed playing time
  2. Play bar
  3. File/Bit format
  4. Singer name
  5. File/Song name
  6. Repeat/Random/A-B Repeat/Intro Scan
  7. Play/Stop
  8. Current file/song number
  9. Total file/song number
10. Bass boost
11. Total play time
12. Battery
13. Hold

4
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a 0001 / 0020
A V B F X R

Song 0001
Artist-0001

MP3  128kbps

00 : 00 : 12   / 00 : 05 : 46

BASS

7 8 9

1213

6

10

111
2
3
4
5

Recommended PC environment
Supported PCs

IBM PC/AT compatible
Supported OS

Windows XP Professional
Windows XP Home Edition
Windows 2000 Professional
Windows Millennium Edition(Me)

USB port
One required for connection

Sound board
16-bit Windows-compatible sound board supported

Other
Speakers or headphones required

Note:
- Operation is not guaranteed for Macintosh PCs.
- Operation is not guaranteed for the following

environments.
Upgraded Windows environments
Windows 95, 98, 98SE, NT
Dual-boot Windows environments

- Standby, suspend, and other modes may not work
properly with your particular environment. If this is the
case, do not use those modes.
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Note:
- Do not use an USB hub or USB extension cable

(Operation is not guaranteed). Use only the supplied
USB cable for connection.

- When you connect the player to the PC for the first
time, it sometimes may not be recognised as a
Removable Disk. In this case, disconnect the player
and reconnect it again.

1. Turn on your PC and Windows is started.
2. If the player is turned on, press [a/n z] (for at least 2

seconds) to turn the player off.
3. Connect the player to the PC with the USB cable.

When the player is connected to the PC, it automatically
enters to the battery charging mode.
“ ” is displayed on the display while charging. When
the charge is completed, “ ” appears.
- Fully charge the battery before using the player for the

first time.
- The battery is fully charged approximately 4 hours.

How to connect the player to your PC

Selecting the action Windows is to take (Windows
XP only)
After connection, the following screen will appear.

Adjust your settings to match your PC’s environment.
In this manual, [Take no action] is selected, [Always do
the selected action] is checked, and [OK] is clicked. This
completes the connection to the PC.
- For WindowsME/2000, this operation is not needed.

When connected to the PC, the player display will be as
shown below and none of the operating buttons will work.

Before disconnecting the player from the PC, be sure to
follow the steps on page 8. Do not disconnect during data
transfer.

PC

3) Click

1) Select

2) Check

Pay attention to the
direction of the terminal

Original USB cable
(supplied)

Connected to PC Transmitting to/from PC

PC

Stop Moving
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How to install the MusicFileMaster software
- Reproduction of this software is forbidden.
- This software shall not be copied and reprinted.
- SANYO shall not be liable for any damages arising out

of the use of this software.

- The screen shots are of Windows XP.
- The screens displayed on your PC may not exactly

correspond to those shown in this manual depending
on the OS version and manufacturer.

Connect the player to your PC (refer to page 5).

To start up Explorer
1. Click [start], then right-click [My Computer], and select

[Explore] from the menu that appears.

Explorer will start up.
2. [Removable Disk (F:)] icon will appear in My Computer

in Windows.
“F” (drive letter) is replaced by your drive letter.

Copying [MusicFileMaster] and [Manual] folders to
your PC for backup
Click [Removable Disk (F:)]. Select [MusicFileMaster] and
[Manual] folders, and drag and drop them into a folder of
your choice on your PC.
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Installing the MusicFileMaster software
1. In the step 2 on the previous page, click [Removable

Disk (F:)] > [MusicFileMaster] folder.
2. Double click [Setup.exe] in [MusicFileMaster] folder.

[InstallShield Wizard] screen appears.

Click [Next].
3. Check “License Agreement” then click [Yes].

MusicFileMaster is not installed if you do not agree to
the license agreement.

4. Enter the user name then click [Next].

5. Select a folder where setup will install the files. Check
“Destination Folder” then click [Next].

To install to a different folder, click [Browse...] and
select another folder.

6. After the setup has finished installing MusicFileMaster
software, click [Finish].

[MusicFileMaster] and [SANYO HDP DMP support]
icons appear on the desktop.

Also Manual folder is installed to “C:\Program
Files\SANYO\Manual” (in this example) when the
installation of MusicFileMaster is performed.

Note:
Do not delete, move, or modify the installed folders/files.

[SANYO HDP DMP support]: For downloading the
latest software, etc. from our web site.

http://www.sanyo-audio.com/english/index.html

How to open the instruction manual
1. In the step 2 on the previous page, click [Removable

Disk (F:)] > [Manual] folder.

or

Open the [Manual] folder blow:
C:\Program Files\SANYO\Manual (in this example)

2. Double click the desired file (Example: [HDP-M3000
Instruction Manual English.pdf]).

Adobe (Acrobat) Reader is necessary to view the PDF file.
If you have not the Adobe Reader installed, see http://
www.adobe.com/products/acrobat/readermain.html to
download the Adobe Reader.
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Disconnecting the player from your PC
Before disconnecting, make sure no data is being
transferred.

1. Right-click the Task tray icon at the bottom right of the
Windows screen.

If the icon is not displayed, refer to the Windows help.
2. Click [Safely Remove Hardware] displayed.

3. Select [USB Mass Storage Device] and click [Stop].

4. Check that [SANYO HDD PLAYER USB Device] is in
the list, select [USB Mass Storage Device] and click
[OK].

5. Disconnect the player from your PC.

How to check whether the player has recognised correctly or not
1. Connect the player to your PC (refer to page 5).
2. [start] menu > right-click [My Computer] > select

[Properties] to open [System Properties] > click [Device
Manager] in [Hardware] tab to open [Device Manager].

3. Double click [Disk drives] > double click [Universal
Serial Bus controllers]. If the following screen is
displayed, it means the player has recognised correctly.
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Removable Disk display
An icon [Removable Disk] will appear in My Computer in
Windows when the player is connected to your PC.

[MUSIC] folder
Files transferred from your PC are stored in this folder.
- There is no set format for file names for files which are

transferred, but they must be MP3 or WMA files.
- The playback order will change if the files in MUSIC

folder are added. Also the same is said of the case of
the directly created folder in the MUSIC folder.

- You can create a folder in the MUSIC folder and move
files to that folder.
Files in subfolders up to two levels below the MUSIC
folder can be played.

- The player can recognize up to 250 files in the MUSIC
folder.

[DATA] folder
This folder stores data files (Excel, Word, etc.) as a
Removable Disk.

[PLAYLIST] folder
This folder stores playlist files.
- The player can recognize up to 250 files in the PLAYLIST

folder.

[MusicFileMaster] folder
This folder is for installing MusicFileMaster.

[Manual] folder
This folder stores instruction manual files.

[INFSYS.SPR]
Hidden file containing the player information reads by the
PC application. Do not delete.
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MusicFileMaster
You can select music files on your hard disk and manage
them using MusicFileMaster, by reading them into the
application. MusicFileMaster enables you to transfer music
files to your portable device, and manage the transferred
music files.
MusicFileMaster has two modes.
Library mode: In this mode you can play and manage

music files and create playlists.
Portable device mode: In this mode, you can transfer

music files to your portable device, manage them, and
play music files which are on your portable device.

Starting up the MusicFileMaster
Connect the player to your PC (refer to page 5).
Double click [MusicFileMaster] icon created on the desk
top to start up the MusicFileMaster.

Note:
It is recommended to end all Windows applications before
start-up.

Controls in the MusicFileMaster window
For details, please refer to the on-line help.

  1. Menu bar
Menus for operations are displayed.

  2. Mode selection buttons
  3. Music file information
  4. Spectrum analyser

  5. Library
Music file list in your PC is displayed.
The list is displayed in [Library] mode. [All Songs],
[Artist/Album], [Album], [Genre] and [Format] can be
displayed individually.

  6. Playlist
Playlists in your PC are displayed.

  7. Library in portable device
List of music information in portable device is displayed.

  8. Music information in your PC
  9. Music information in device
10. List control buttons
11. End button

This button is used to end the MusicFileMaster.

How to use on-line help
Start up the MusicFileMaster and select the [Table of
Contents] in the [Help] menu. Refer to detailed information
on the menu.

Starting up the MusicFileMaster
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Transferring data by MusicFileMaster
Start up the MusicFileMaster (refer to page 10).

Transferring data to the player
After selecting [Help] menu > [Table of Contents], click
[Basic operations] > [Transferring music files to portable
device] of the [Portable device]. Then, transfer files
according to the instruction displayed on the screen.

Note:
- Registration of too many pieces of music may make

the player action slower. It is recommended to register
about 5,000 pieces at maximum as standard
registration.
The player may not work depending on the environment
of your PC.

- Only the files of MP3 and WMA formats (without
copyright) can be transferred to the device and played
back by MusicFileMaster. However, a file which has
the extension of RMP (Riff MP3) can not be played
back. All files of MP3 and WMA formats including
variable bit rate can be transferred, but may not be
played back correctly.

Copying data by using Explorer
Start up Explorer (refer to page 6).

(1) Copying files to the player
Select the music files to copy and drag and drop them to
[MUSIC] folder in [Removable Disk].

(2) Copying files to your PC
Select the music files you wish to copy inside [MUSIC]
folder in [Removable Disk] and drag and drop them into a
folder of your choice on your PC.

1 2

Note:
- Place files you wish to play either in the MUSIC folder

or any subfolders two levels below the MUSIC folder.
- Files larger than 4GB cannot be transferred.
- Some MP3/WMA files may not be able to be played on

this player.
- Any MP3 or WMA files that you transfer and that are

not for your own personal enjoyment may not be used
without permission from the copyright holder, as
stipulated by intellectual copyright law.

- You can search for music files transferred using Explorer
or Windows Media Player. Use [Remake Management
File of Device] function in MusicFileMaster’s [Tools]
menu.
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Transferring data using the Media Player
If you have the Microsoft Windows Media Player installed,
you can transfer WMA files to the player and listen to them.
See the Windows Media Player on-line help for details on
how to do this.

Note:
- Use Windows Media Player 10 when transferring

music distribution data (in WMA format) which uses
DRM10 copyright protection to the Player.
First, select “WMPlayer10 (DRM10)” in the “PC
Connecting Mode” setting (refer to page 22).

- Never disconnect the player from your PC during
transfer.

- Files in subfolders up to two levels below the MUSIC
folder can be transferred.

Precaution when copying WMA files to the player:
Transfer from your PC to the player and/or playback are
impossible in the following cases.
- Music files which are copyright protected
- Music files purchased over the Internet
(This does not apply when transferring music distribution
data (in WMA format) which uses DRM10 copyright
protection to the Player using Windows Media Player 10.)

Formatting the player’s data

Designating the playback order (Playlist)
It is possible to designate the playback order of music.
Create a playlist on your PC and transfer it to the player to
play your music in that order.
It is also possible to transfer two or more playlists to the
player.

1. Start up the MusicFileMaster (refer to page 10).
2. After selecting [Table of Contents] in [Help] menu,

click [Basic operations] > [Creating / deleting portable
device playlists] of [Portable device]. Then, store the
data according to the instruction displayed on the
screen.

Always format data using the player itself (refer to page
19).

Note:
- If you select the format function from the menu, the

memory will be initialised and all files will be erased.
Use only when you need it. Save a backup copy of your
data on a PC, etc.

- The player might not operate normally if formatting the
player with your PC.

- If you accidentally formatted using your PC, reformat
it using the player.
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Battery indicator
“ ” indicates that the battery is full and the power in
battery will be come less when using.
“ ” indicates low battery power and the  battery should
be charged.

Hold function
This prevents operation from stopping by accidentally
pressing a button.

Set [b HOLD] to the left. “Hold On” appears briefly and the
hold function is engaged.

- If an operation button is pressed while the hold function
is engaged, “Hold On” will appear and nothing else
happens.

Set [b HOLD] to the right. “Hold Off” appears briefly and
the hold function is disengaged. The hold indicator
disappears.

To adjust the volume
Press [o] or [p]. The volume level appears.

Using the headphones
Connect the headphones to the  socket.

Turning the power on and off

Press [a/n z] (for at least 2 seconds). “HELLO” appears
briefly on the display and the power turns on.

The last selected mode appears (Resume function).
Example:

Press [a/n z] (for at least 2 seconds). “SEE YOU” appears
and the power turns off.

Examples of menu/mode display

Music mode Main menu

USB mode System setting

Before playing

Setting up the beep sound (refer to page 21)
Changing auto power off time (refer to page 21)
Setting up sleep time (refer to page 22)
Adjusting the contrast of LCD display (refer to page 22)
Setting up backlight time (refer to page 22)

a/n z

b HOLD

a 0001 / 0020

Love song_0001
Artist-0001

MP3  128kbps

00 : 00 : 15   / 00 : 04 : 04

Hold On

o

cd

p

N 00 : 00 : 00

MUSIC
EXIT

PC

n 00 : 00 : 00

System  Settings
Beep
Auto  Off
Sleep
Contrast
Backlight
Menu  Reset

n 0001 / 0020

Song 0001
Artist-0001

MP3

00 : 00 : 00   / 00 : 00 : 00

BASS

n 0001 / 0020

Song 0001
Artist-0001

MP3

00 : 00 : 00   / 00 : 00 : 00

BASS

VOLUME

07

Hold

(VOLUME 00 to 30)

“WAITING” is displayed when accessing the hard disk takes some time.
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5. Press [o] or [p] to select “Preset Time”, then press [m]
or [c]. The player enters to the date and time setting
mode. The year display selects.

6. Press [o] or [p] to select the year, then press [m] or
[c]. The month display selects.

7. Set the month, day, hour and minute by following step
6 above.
When the minute setting is completed then press [m],
“Clock Settings” menu returns.

8. Press [MENU] to quit the menu setting mode.

If no adjustments are made in the menu setting, the original
display returns after approximately 30 seconds.

1. In the stop mode, press [m] (for at least 2 seconds). The
first stage menu appears.

2. Press [d] or [c] to select “SETTINGS”.

3. Press [m]. “SETTINGS” menu appears.

- Press [d] once during the menu setting. The
setting is cancelled and the previous menu returns.

4. Press [o] or [p] to select “Clock Settings”, then press [m]
or [c]. “Clock Settings” menu appears.

Date and time setting

Setting up the clock display mode (refer to page 22)
Setting up the clock to 12-hour or 24-hour display (refer to page 22)

o

cd

p

N 00 : 00 : 00

MUSIC
EXIT

o

cd

p

k 00 : 00 : 00

SETTINGS

SETTINGS

n 00 : 00 : 00

Play  Settings
File  Menu
System  Settings
Clock  Settings
PC Connecting Mode

Clock Settings

n 00 : 00 : 00

Preset  Time
Clock  Type
12h/24h

Preset Time

n 00 : 00 : 00

      2005Y   01M   01D
      01 : 00

Preset Time

n 00 : 00 : 00

      2005Y   01M   01D
      01 : 00



-15-

6. Press [m]. Playback begins.

- Music (song)/Artist name may not display on some
music files.

Playing the selected music file in the FOLDER menu
For the case when files are transferred by Explorer and
Windows Media Player
1. In the stop mode, press [m] (for at least 2 seconds). The

first stage menu appears.
2. Press [d] or [c] to select “FOLDER”, then press

[m]. MUSIC folder appears.
3. Press [m] again. The list of items appears.

4. Press [o] or [p] to select the desired folder.
- For details of the playback mode, please refer to

“Examples of playback mode selection display” in
page 17.

5. Press [m]. The list of music files for selected folder is
displayed.

- When searching the music file for more folder,
repeat steps 4 and 5.

6. Press [o] or [p] to select the music file you want to play
back.

7. Press [m]. Playback begins.

Playing the selected music file in the MUSIC menu
Valid only for music files transferred by MusicFileMaster
1. In the stop mode, press [m] (for at least 2 seconds). The

first stage menu appears.

2. Press [d] or [c] to select “MUSIC”, then press [m].
The playback mode selection display appears.

3. Press [o] or [p] to select the desired mode, then press
[m]. The list of items for selected playback mode
appears.

- For details of the playback mode, please refer to
“Examples of playback mode selection display” in
page 17.

4. Press [o] or [p] to select the item you want to play back,
then press [m].

5. Press [o] or [p] to select the music file you want to play
back.

- When searching the item for more detail, repeat
steps 4 and 5.

- Press [d] once during the menu setting. The
setting is cancelled and the previous menu returns.

Play music

ALL  SONGS

n 00 : 00 : 00

ALL  SONGS
ARTIST
ALBUM
GENRE
PLAYLISTS

ARTIST

n 00 : 00 : 00

 [ALL]
Unknown
Artist-0001
Artist-0002
Artist-0003
Artist-0004

MUSIC

n 00 : 00 : 00

My Best001Artist
My Best002
Love Song001
Love Song002
Hit-Chart001
Hit-Chart002

a 0003 / 0020

Song 0003
Artist-0003

MP3  128kbps

00 : 00 : 02   / 00 : 04 : 38

a 0003 / 0020

Song 0003
Artist-0003

MP3  128kbps

00 : 00 : 02   / 00 : 04 : 38

Love Song001

n 00 : 00 : 00

Song 0001
Song 0002
Song 0003
Song 0004
Song 0005
Song 0006

Elapsed playing time

Music (song) name
Music file number

Artist name

N 00 : 00 : 00

MUSIC
EXIT

ARTIST

n 00 : 00 : 00

Song 0001
Song 0002
Song 0003
Song 0004
Song 0005
Song 0006

For Playlists playback: Create a playlist on the
MusicFileMaster and transfer it to the player before starting
playback.
Press [MENU] during play mode. The previous menu
setting appears. Press [MENU] again to return to the play
mode.

Press [MENU] (for at least 2 seconds) during playback.
The list of files appears. Press it for at least 2 seconds
again. The file information appears.
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Note:
- Name of artist or album may not be displayed depending

on the music file.
- Registration of too many pieces of music may lower

the player performance. It is recommended to register
about 5,000 pieces at maximum as standard
registration.

To stop playback
Press [m] or [a/n z].

Press it again to resume playback.

Note:
- A few seconds may be required to start playback for

large files or an extremely large number of files.
- Depending on the MP3/WMA file, the displayed playing

time may be at variance with the actual playing time.
- Some MP3/WMA files may not be able to be played on

this player.

Fast forward play
Press [c] during playback and hold it.
Release [c] to resume normal playback.

Fast reverse play
Press [d] during playback and hold it.
Release [d] to resume normal playback.

To skip to the next or previous file
Press [c] or [d] during playback or stop.

Selecting the repeat playback
Press [REPEAT] (for at least 2 seconds) to select the
repeat mode. Each time [REPEAT] is pressed (for at least
2 seconds), the repeat mode changes as follows:

1 X: Plays a single file repeatedly.
F X: Plays all files in the current folder repeatedly

(only for FOLDER playback).
A X: Plays all files (or all files in the selected

ARTIST, ALBUM or GENRE) repeatedly.
Released: Repeat off.

- This setting can also be carried out in the menu setting
mode (refer to page 21).

A-B repeat playback
1. During playback, press [REPEAT] at the beginning of

the section you want to repeat (Point A).

2. Press [REPEAT] again at the end of the section you
want to repeat (Point B). The specified section (between
points A and B) is played back repeatedly.

Press [REPEAT] again to cancel.

n 0003 / 0020

Song 0003
Artist-0003

MP3  128kbps

00 : 03 : 18   / 00 : 04 : 38

a 0003 / 0020
1 X

Song 0003
Artist-0003

a 0003 / 0020
A V 

Song 0003
Artist-0003

MP3  128kbps

00 : 01 : 23   / 00 : 04 : 38

a 0003 / 0020
A V B

Song 0003
Artist-0003

MP3  128kbps

00 : 02 : 10   / 00 : 04 : 38

Setting up the repeat playback (refer to page 21)
Setting up the random playback (refer to page 21)
Setting up the bass boost (refer to page 21)
Setting up the sound equalizer (refer to page 21)
Setting up the intro function (refer to page 21)
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MUSIC menu (Valid only for music files transferred by MusicFileMaster.)

ALL SONGS: Display of all the music files

ARTIST:
[ALL]

[ALL]: Display of all the music files
Display of all the album names – Hereafter is same as ALBUM search.

Display of all the artist names
[ALL]: Display of all the music files of the selected album
Display of all the album names of the selected artist – Display of all the music files of the selected album

ALBUM:
[ALL]: Display of all the music files
Display of all the album names – Display of all the music files of the selected album

GENRE:
[ALL]

[ALL]
[ALL]: Display of all the music files
Display of all the album names – Hereafter is same as ALBUM search.

Display of all the artist names – Hereafter is same as ARTIST search.

Display of all the genre names
[ALL]

[ALL]: Display of all the music files of the selected genre
Display of all the album names of the selected genre – Display of all the music files of the selected album

Display of all the artist names of the selected genre
[ALL]: Display of all the music files of the selected artist
Display of all the album names of the selected artist – Display of all the music files of the selected album

PLAYLISTS: Display of all the playlists

FOLDER menu (For the case when files are transferred by Explorer and Windows Media Player)

MUSIC:
Display of all the folders

Display of all the folders in the selected folder – Hereafter is repeated the same search procedure.
Display of all the music files in the selected folder

Display of all the music files

Examples of playback mode selection display
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Note:
Use of the [Remake Management File of Device] function of the [Tools] menu of the Music File Master enables you to
search for the piece of music which has been transferred by Explorer or Windows Media Player.
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3. Press [o] or [p] to select “File Menu”, then press [m] or
[c].

4. Press [m] or [c].

5. Press [o] or [p] to select “Yes”, then press [m].
“Formatting”, then “Format complete!” appears and all
files are erased.

Note:
If you do not want to format, select “No”.

Note:
Formatting is not possible during playback.

(Erasing all files in all folders)
If you select the format function from the menu, the
memory will be initialised and all files will be erased. Use
only when you need it. Save a backup copy of your data on
a PC, etc.

1. In the stop mode,  press [m] (for at least 2 seconds).
The first stage menu appears.

2. Press [d] or [c] to select “SETTINGS”, then press
[m].

Format

n 00 : 00 : 00

              Format
No
Yes

SETTINGS

n 00 : 00 : 00

Play  Settings
File  Menu
System  Settings
Clock  Settings
PC Connecting Mode

File Menu

n 00 : 00 : 00

Format

N 00 : 00 : 00

MUSIC
EXIT

Formatting
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Menu function table

Stage 1 Items

MUSIC ALL SONGS, ARTIST, ALBUM, GENRE, PLAYLISTS

FOLDER MUSIC

SETTINGS Stage 2 Stage 3

Play Settings Repeat Off, One, Folder, All
Random Off, On
Bass Off, On
Equalizer Normal, Pop, Rock, Jazz, User EQ
Intro Scan Off, 5 sec, 10 sec, 15 sec

File Menu Format No, Yes

System Settings Beep Off, On
Auto Off Off, 01 - 15
Sleep Off, 10 - 90
Contrast 01 -10
Backlight Off, 5 sec, 15 sec, On
Menu Reset Yes, No
Player Info Checking the version number and memory information

Clock Settings Preset Time Date and time setting
Clock Type Digital 1, Digital 2
12h/24h 12h, 24h

PC Connecting Mode USB Mass Storage, WMPlayer10 (DRM10)

CLOCK Displays the date and time currently.

EXIT To exit from the menu mode.

Menu setting
Common procedures of menu setting
1. In the stop mode, press [m] (for at least 2 seconds). The

first stage menu appears.
2. Press [d] or [c] to select the first stage menu, then

press [m] to confirm the menu.

“MUSIC” wv “FOLDER” wv “SETTINGS” wv “CLOCK”
wv “EXIT” wv “MUSIC” wv ...

For SETTINGS menu:
The second stage menu appears.

3. Press [o] or [p] to select the second stage menu, then
press [m] or [c] to confirm the menu.
The next stage menu appears.

4. Select the menu and confirm it in the same way.
5. To change the setting of the selected menu, press [o]

or [p]. Then press [m].
When the setting is completed, the current menu
returns.
- Press [d] once during the menu setting. The

setting is cancelled and the previous menu returns.
6. Press [MENU]  to quit the menu setting mode.
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MUSIC
Setting up the playback mode
Playing the selected music file
Specify a playback mode (ALL SONGS, ARTIST, ALBUM,
GENRE or PLAYLISTS), and search it, and playing music
file.

ALL SONGS: Selects all the files.
ARTIST: Selects the files by artist
name.
ALBUM: Selects the files by album
name.
GENRE: Selects the files by genre
name.
PLAYLISTS: Plays the files in the
playlist.

FOLDER
Plays the files in the selected folder.

SETTINGS
Play Settings
Repeat: Setting up the repeat playback

Off: Repeat off.
One: Plays a single file repeatedly.
Folder: Plays all files in the current
folder repeatedly (only for FOLDER
playback).
All: Plays all files repeatedly.

Random: Setting up the random playback
Plays files in the current folder randomly.

Off: Off
On: On

Random playback is not possible
during All repeat mode.

Bass: Setting up the bass boost

Off: Off
On: On

Equalizer: Setting up the sound equalizer

Normal: Deactivates the Equalizer
function
Pop: Pop
Rock: Rock
Jazz: Jazz
User EQ: User EQ (You can adjust as
desired)

[d] or [c] : Select band.
[o] or [p] : Adjust level.

Intro Scan: Setting up the intro function

Off: Off
5 sec/10 sec/15 sec: Plays the first 5,
10, or 15 seconds of each file.

File Menu
Format: Formatting (refer to page 19)

System Settings
Beep: Setting up the beep sound

Off: Beep off
On: Beep on

Auto Off: Changing auto power off time
If you don’t press any button for a certain period of time, the
power will be automatically turned off.
You can change the automatic power off time.

OFF: Off
01 - 15: 01 - 15 (minute)

Root

n 00 : 00 : 00

MUSIC

Repeat

n 00 : 00 : 00

Off
One
Folder
All

Random

n 00 : 00 : 00

Off
On

Bass

n 00 : 00 : 00

Off
On

Equalizer

n 00 : 00 : 00

Normal
Pop
Rock
Jazz
User EQ

n 00 : 00 : 00

Intro  Scan

n 00 : 00 : 00

Off
5  sec
10  sec
15  sec

ALL  SONGS

n 00 : 00 : 00

ALL  SONGS
ARTIST
ALBUM
GENRE
PLAYLISTS

AUTO
POWER OFF

05

Beep

n 00 : 00 : 00

Off
On
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Clock Settings
Preset Time: Date and time setting (refer to page 14)

Clock Type: Setting up the clock display mode

Digital 1: Display mode 1
Digital 2: Display mode 2

12h/24h: Setting up the clock to 12-hour or 24-hour
display

12h: 12-hour display
24h: 24-hour display

PC Connecting Mode
Setting up the PC connecting mode.

USB Mass Storage: For the case when
transferring files by Explorer, etc.
WMPlayer10 (DRM10): For the case
when transferring music distribution
data (in WMA format) which uses
DRM10 copyright protection to the
Player.

CLOCK
Displays the date and time currently.

To cancel this mode, press [MENU]
once or press [m] (for at least 2 seconds)
while the clock is displaying.

EXIT
To exit from the menu mode.

Sleep: Setting up sleep time
The sleep time function turns off the player after a specified
period of time.
It is convenient when you want to sleep while listening to
the music.

OFF: Off
10 - 90: 10, 20, 30, 40, 50, 60, 70, 80
or 90 (minute)

Contrast: Adjusting the contrast of LCD display

01 - 10: 01 - 10

Backlight: Setting up backlight time

Off: Off
5 sec/15 sec: Turn off the backlight
after 5 or 15 seconds
On: Always on

Menu Reset
Return menu setting to Preferences.

Yes: Reset it
No: Do not reset it

Player Info: Checking the version number and memory
information

Version: Version number
TOTAL SPACE: Total capacity
FREE SPACE: Remaining capacity

SLEEP

OFF

CONTRAST

05

Backlight

n 00 : 00 : 00

Off
5 sec
15 sec
On

Player Info

n 00 : 00 : 00

Version 1.00

TOTAL SPACE  5.71  GB
 FREE SPACE  5.57  GB

Menu Reset

n 00 : 00 : 00

Yes
No

Clock Type

n 00 : 00 : 00

Digital 1
Digital 2

12h/24h

n 00 : 00 : 00

12h
24h

n 00 : 00 : 00

PC Connecting Mode

n 00 : 00 : 00

USB Mass Storage
WMPlayer10(DRM10)



-23-

Troubleshooting guide

Symptom
Possible cause

Corrective action

The player does not start.
Charging battery has run down.

Charge the built-in battery.
Internal HDD error.

Format (initialize) the internal HDD.

Buttons do not respond.
The hold function is set.

Turn off the function.
The USB cable is still connected.

Disconnect the USB cable.

No sound.
The volume is turned down too low.

Adjust the volume.

Files cannot be played (correctly or at all).
The file is not in a playable format.

Use MP3 (MPEG1 Audio Layer3)/WMA-format
files.

“MPEG1 Audio Layer2” cannot be played.
In this case,
Please convert from “MPEG1 Audio Layer2” to
MP3 file or get MP3 (MPEG1 Audio Layer3) file.

Files on the PC were not transferred to the MUSIC
folder.

Transfer them to the MUSIC folder on [Removable
Disk].

This is data which cannot be played on the player.
Create a file using different encoder (MP3/WMA
conversion) software.

In selection of music piece, it is impossible to make a
search for artist, album and genre.

The database of the transferred musics is not created.
Create the database of the pieces of music
transferred by [MusicFileMaster].
For detailed information of recreation of database,
please refer to the on-line help of [MusicFileMaster].

Symptom
Possible cause

Corrective action

The Removable Disk is not displayed when the player is
connected to the PC.

The PC and the player are not connected correctly.
Make sure the connect is corrected.
Disconnect the USB cable from the PC and
reconnect it again.

Sufficient power is not being supplied from the PC.
If a USB hub is being used, reconnect the player
directly to the USB port on the PC. If the PC is
equipped with several different USB ports, try
another port.

A network drive has been assigned.
If a network drive has been assigned, the drive
letter (the letters used as drive names) is already
taken, so the Removable Disk cannot be created.
Change the network drive assignments and
reconnect. Talk to your network administrator about
reassigning network drives.

Player is not recognised correctly by MusicFileMaster.
MusicFileMaster was started up immediately after
formatting the player by PC.

Format it by player and connect the player to your
PC before starting up the MusicFileMaster. (Refer
to page 19)

WHAT TO DO IF...
If the operation of the player or display is not normal,
1. Press [RESET] using a small ball-point pen, etc.
2. Resume operation.

This operation should not be performed under ordinary
circumstances.

b HOLD

[RESET]
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Cleaning the cabinet
Clean the outside of the player with a clean soft cloth, moistened with lukewarm water. Do not use benzene, thinner or
alcohol since they will mar the finish of the surfaces.

Specifications
Internal HDD: 6 GB
Frequency response (playback): 20Hz - 20kHz
Music playback capability:

MP3 [MPEG1 Audio Layer3] (16 - 44.1kHz, 16 - 192kbps)
WMA [Windows Media Audio] (16 - 44.1kHz, 32 - 160kbps)

Terminals: USB,  (Headphones)
Output power: 8mW + 8mW
Power source: Lithium Ion battery x 1
Full charging time: Approx. 4 hours
Max. Play time: 12 hours
Dimensions  (W x H x D): Approx. 51 x 89 x 19 mm
Weight: Approx. 87 g

Specifications subject to change without notice.

You can download the latest software, if available, from our web site.
http://www.sanyo-audio.com/english/index.html

The optional AC adaptor is available.
Model No.: D-5V-USB

This set complies with the EMC Directive 89/336 and with the LVD Directive 73/23.

SANYO Electric Co., Ltd.


